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This manual is part of a set of Fiery S300 50C-K

 

™

 

 documentation that includes the 
following manuals for users and system administrators. Most are available as Acrobat 
PDF (Portable Document Format) files on the User Documentation CD.

• The

 

 Quick Start Guide

 

 summarizes the steps for configuring the Fiery S300 50C-K 
and printing. It also describes how to access the Acrobat PDF files on the User 
Documentation CD. 

• The

 

 User Software Installation Guide 

 

describes how to install software from 
the User Software CD to enable users to print to the Fiery S300 50C-K, and also 
describes setting up printing connections to the Fiery S300 50C-K.

• The

 

 Configuration Guide 

 

explains basic configuration and administration of 
the Fiery S300 50C-K for the supported platforms and network environments. 
It also includes guidelines for setting up UNIX, Windows NT 4.0/2000, 
Windows Server 2003, and Novell NetWare servers to provide printing services 
to users. 

• The

 

 Printing Guide

 

 describes the printing and scanning features of the 
Fiery S300 50C-K for users who send jobs from their computers.

• The

 

 Color Guide 

 

provides information on managing the color output of the 
Fiery S300 50C-K. It explains how to calibrate your copier and take advantage 
of the ColorWise

 

®

 

 color management system, as well as features in ColorWise 
Pro Tools

 

™

 

. 

• The

 

 Fiery Color Reference 

 

addresses concepts and issues associated with managing 
color output of the Fiery S300 50C-K and outlines key workflow scenarios. 
In addition, it offers information on printing color documents from popular 
Microsoft Windows and Apple Mac OS applications.

• The

 

 Job Management Guide 

 

explains the functions of the job management utilities, 
including Command WorkStation

 

™

 

, Command WorkStation LE

 

™

 

, and DocBuilder

 

 

 

Pro

 

™

 

, and how you can use them to monitor and control jobs on the 
Fiery S300 50C-K. This manual is intended for an operator or administrator, 
or a user with the necessary access privileges, who monitors and manages job flow, 
performs color calibration, and troubleshoots problems that may arise.

•

 

Release Notes

 

 provide last-minute product information and workarounds for some 
of the problems you may encounter.

About the 
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice

This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de l’Industrie Canada 

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is 
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software 
or use the Software in any time sharing, service bureau, or similar arrangement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to localize, translate, disassemble, 
decompile, decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, and upgrades related to the 
Software.



              
Proprietary Rights

You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the Software, Documentation and all 
modifications and derivative works thereof are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted above 
to use the Software, no right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether 
registered or unregistered). You agree not to adopt, register, or attempt to register any EFI trademark or trade name (“EFI Mark”) or any confusingly similar mark, 
URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any other action which impairs or reduces 
the trademark rights of EFI or its suppliers. 

Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of 
your rights under this Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations, 
including the U.S. Export Administration Regulations, (2) you transfer to the person or entity all of the Software and Documentation (including all copies, 
updates, upgrades, prior versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and 
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this Agreement. 

Remedies and Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make 
available to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software, Documentation, and all component parts thereof. 
All provisions of this Agreement relating to disclaimers of warranties, limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s 
proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no 
warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or hardware. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI 
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY 
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD 
PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or 
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE 
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations. 
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws 
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987) 



   
Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per 
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015 
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superceded, the 
subsequent or equivalent regulation shall apply. The name of the Contractor is Electronics For Imaging. 

General

The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of California exclusively, as such laws 
apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International Sale of 
Goods and any other similar convention does not apply to this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive 
jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is the 
entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If any provision of this Agreement is held 
invalid, such provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this Agreement shall continue in full force 
and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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xi About this manual

                   
This manual describes how to install user software for the Fiery S300 50C-K™, 
and how to set up printing from Microsoft Windows and Apple Mac OS 
computers. For information about setting up network servers and clients to use the 
Fiery S300 50C-K, see the Configuration Guide. For general information on using 
the copier, your computer, application software, or network, see the manuals that 
accompany those products.

NOTE: The term “Fiery S300” is used in this document to refer to the Fiery S300 
50C-K. The term “50C-K” is used to refer to the copier. The term “Aero” is used in 
illustrations to represent the Fiery S300. The term “Windows 9x” is used in this 
document to refer to Windows 98. The term “Windows” is used in this manual to refer 
to Windows 98, Windows Me, Windows NT 4.0, Windows 2000, and Windows XP, 
wherever appropriate. 

NOTE: Illustrations of Windows software may not necessarily reflect the version of 
Windows that you use.

The Fiery S300 includes support for Fiery WebTools™ and software for Command 
WorkStation, which enables an operator to manage all jobs sent to the Fiery S300. 
Although it may not be the case at all sites, the documentation for this product 
assumes the presence of an operator who controls and manages jobs sent by users 
from remote workstations.

About this manual
This manual covers the following topics:

• Installing printer files on Windows and Mac OS computers

• Setting up printing connections on Windows and Mac OS computers

• Installing Fiery® utilities/other user software on Windows and Mac OS computers

Introduction
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Specifications
• 2 GHz Intel Pentium IV CPU

• 512MB RAM

• 60GB hard disk drive

• An internal DVD drive

• A 250MB ZIP drive for removable media (optional)

• Supports the Fiery Advanced Controller Interface (FACI), which includes a monitor, 
a keyboard, and mouse

• Supports AppleTalk, TCP/IP, and IPX/SPX protocols simultaneously

• Supports Port 9100

• Supports unshielded twisted pair (Gigabit Ethernet 1000BaseTX, Fast Ethernet 
100BaseTX, or Ethernet 10BaseT)

• Supports Internet Printing Protocol (IPP) for Windows 98, Windows Me, Windows 
2000, and Windows XP

• Supports Adobe PostScript 3

• Includes 136 fonts (126 Adobe Type 1 PostScript and 10 TrueType)

• Built-in ColorWise™ color management and NetWise™ networking management

• Supports Fiery utilities and Fiery WebTools (see following sections)

• Fiery utilities, including EFI Fiery Downloader™, Fiery Scan™, Fiery Remote 
Scan™, and Fiery Spooler™

• Fiery WebTools, including Status™, WebSetup™, WebLink™, Installer™, 
WebDownloader™, and WebScan™

• Fiery VDP Resource Manager™

• Command WorkStation (Windows only) software

• Command WorkStation LE (Mac OS X Native only) software

• Supports DocBuilder Pro
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• Fiery Graphic Arts Package™ 

• Supports Fiery FreeForm™ 

• Supports EFI Densitometer ED-100 (available as an option)

• Supports EFI ES-1000 Spectrometer (available as an option)

• Supports Pageflex Persona Variable Data package (available as an option)

• Supports PrintShop Mail Variable Data package (available as an option)

• Supports E-mail printing

NOTE: Fiery utilities and Fiery S300 user software can be installed on the Fiery S300 
from the User Software CD, using the Fiery Advanced Controller Interface. Other 
third-party applications are not supported and may cause system problems.

User software
Fiery S300 user software is provided on the User Software CD.  

Adobe PostScript 
Printer Driver

Enables you to print to the Fiery S300 from 
Windows 9x/Me, Windows NT 4.0, and Mac OS 
computers; also supports Fiery S300 and PostScript 3 
features. Windows 2000/XP users should use the 
Microsoft PostScript Printer Driver provided with 
those operating systems.

PostScript Printer 
Description (PPD) file 

For use with the PostScript printer driver that allows 
the Fiery S300 to appear in the Print and Page Setup 
dialog boxes of popular applications. The Fiery S300 
PPDs provide information about the copier to the 
application and printer driver you are using.

PostScript fonts
(Mac OS only) 

PostScript screen and printer fonts that correspond 
to the PostScript printer fonts installed on the 
Fiery S300. For a complete list of PostScript fonts 
installed on the Fiery S300, see Appendix B of the 
Printing Guide. 
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Fiery Downloader Enables you to print PostScript files, Encapsulated 
PostScript (EPS) files, TIFF version 6.0 files, and 
Portable Document Format (PDF) versions 1.2, 1.3, 
and 1.4 files directly to the Fiery S300 without 
opening the application in which they were created. 
You can also use it to manage the printer fonts installed 
on the Fiery S300.

Fiery Spooler 
(Mac OS Classic mode 
only)

Enables you to view the order and priority of print 
jobs, customize printer settings for jobs, delete jobs, 
and move jobs between queues. You can also use it to 
view job accounting information.

ColorWise Pro Tools ICC-open color management and calibration tools; 
enables you to edit and download ICC profiles.

Fiery Scan, 
Fiery Remote Scan

Stand-alone application and plug-in modules for 
supported TWAIN-compliant application software 
that allow you to scan images from the copier directly 
into the application. To use Fiery Remote Scan, see the 
Printing Guide.

Fiery VDP Resource 
Manager

Allows you to look for and delete global objects used in 
variable printing.

Command WorkStation 
(Windows only)

Enables the operator to control the Fiery S300 
functions from Windows 9x/Me and Windows NT/
2000/XP computers. To use Command WorkStation, 
see the Job Management Guide.

Command WorkStation LE 
(Mac OS X Native 
Mode only)

Enables the operator to control the Fiery S300 
functions from Mac OS X Native Mode computers. 
To use Command WorkStation LE, see the 
Job Management Guide.

EFI Fiery Mail Port 
(Windows only)

Enables you to send jobs to the Fiery S300 in the form 
of e-mail attachments by adding the EFI Fiery Mail 
Port software as a printer port.
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NOTE: You can install PostScript printer drivers and printer description files from 
the User Software CD or from the Fiery S300 with the Installer WebTool. For 
instructions, see “Using the Fiery WebTools Installer” on page 3-2.

PitStop software 
(Windows only)

The PitStop Acrobat plug-in is for use with the 
Command WorkStation DocBuilder Pro feature. 
It offers you enhanced PDF editing and 
preflighting functions.

Fiery Graphic Arts Package Includes Hot Folders, TIFF-IT Converter, Calibrator, 
and Custom Halftones Calibration files.

• Hot Folders—Enables one-time set up of a group of 
print options, which can be applied to any print job.

• TIFF-IT Converter—Converts files to PostScript or 
EPS for printed output on the Fiery S300.

• Calibrator files—Enables calibration of the 
Fiery S300 in Halftone Screen mode.

Color management files ICC (Windows) and ColorSync (Mac OS) color 
management files that enable you to maintain 
consistent color from your original artwork to the 
colors displayed on your monitor and then to the 
printed output.

Color reference files Reference pages that you can print to view the range of 
colors available on your Fiery S300. For the most 
predictable color results, refer to these pages when 
defining colors in applications. For more information 
on color management, see the Color Guide.

Calibration files Includes measurement files and targets that you can use 
with ColorWise Pro Tools.

MRJ (Mac OS only) Mac OS Runtime for Java (MRJ) software is required 
by all Java-based Fiery utilities. If MRJ is not detected 
when you install these utilities, the MRJ installer is 
automatically launched from the User Software CD.
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Fiery WebTools
Fiery WebTools allow you to manage your Fiery S300 remotely from the Internet or 
from your company’s intranet. You access Fiery WebTools from the Fiery 
WebTools home page.

NOTE: To find out which Fiery WebTools are supported, see “Specifications” on 
page xii.

System requirements
System requirements are described in detail in the printed Quick Start Guide provided 
in your media pack.

Fiery WebTools Summary For more information

Status Shows you the jobs currently processing 
and printing.

see the Printing Guide.

WebLink Provides a link to another web page, 
provided you have a valid 
Internet connection.

see the Printing Guide and 
the Configuration Guide.

Installer Allows you to download Fiery S300 
printer file installers directly from 
the server.

see Chapter 3.

WebDownloader Allows you to download PostScript, 
EPS, and PDF files to the Fiery S300.

see the Printing Guide.

WebSetup 
(Windows only)

Allows you to modify the Fiery S300 
configuration (Setup) remotely. This 
function requires the Administrator 
password, if one has been set.

see the Configuration Guide.

WebScan Allows you to view and print images that 
have been scanned to the copier.

see the Printing Guide.
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1-1 Setting up PostScript printing with Windows 9x/Me

           
This chapter describes the procedures for installing software and setting up printing 
from a computer using a supported version of Windows. For the Windows versions 
supported, see the Quick Start Guide. 

The general steps for installing the software are as follows: 

• Install the PostScript printer driver and corresponding printer driver files and set up 
the printer driver to communicate with the Fiery S300.

• Install Fiery utilities and user software—Fiery Graphic Arts Package (available as an 
option), EFI Fiery Mail Port, EFI Fiery Downloader™, Fiery Scan™, Fiery Remote 
Scan™, VDP Resource manager, ColorWise Pro Tools, Command WorkStation, and 
Fiery Spooler™

• Configure the connection for Fiery utilities and user software.

• Install Adobe Acrobat 5.0.5 and PitStop software on the designated 
Windows computer(s).

• Fiery S300Copy additional files from the User Software CD as required.

In addition to using the User Software CD, you can download printer drivers from the 
Fiery S300 with the Installer WebTool (if the administrator has enabled Internet access 
to the Fiery S300). For instructions, see “Using the Fiery WebTools Installer” on 
page 3-2. After you download the printer files, the installation process is identical to 
installing from the User Software CD.

Setting up PostScript printing with Windows 9x/Me
To set up the Fiery S300 as a PostScript printer, you must install the PostScript printer 
driver for Windows 9x/Me and the corresponding printer description files. You must 
also configure either a local connection for printing directly or a network connection 
for printing over the network. 

If you are printing using SMB (Server Message Block, which is also called Windows 
printing), you can connect to the Fiery S300 and install the printer drivers in a single 
procedure. For more information, see “Setting up SMB printing with 
Windows 9x98/Me” on page 1-25.

Chapter 1:
Installing 
User Software 
on a Windows 
Computer
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Installing the PostScript printer driver for 9x/Me
The following procedure describes installing the printer driver from the User 
Software CD or from the Installer WebTool. Subsequent procedures describe 
configuring installable options and setting up the printer connection.

NOTE: The following procedures display Windows 98 illustrations; Windows Me 
differences are noted.

TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 
connection later, according to your network type.

4. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.

5. Type the name of the CD-ROM drive (for example, D:\), and click Browse. 
Browse to \Prntdrvr\Ps_drvr\Win_9x_ME. 

If you are installing from the files you downloaded using the Installer WebTool, 
browse to prntdrvr\Prntdrvr\Ps_drvr\Win_9x_ME.

6. Make sure “Oemsetup.inf” is selected and click OK. 

The path is copied to the Install From Disk dialog box.

7. Verify the path is correct and click OK.
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8. Select the Fiery S300 50C-K as your printer and click Next.

9. Select the LPT1 port and click Next.

You will configure the port later, according to your network type.

10. Enter a name for the printer.

11. To make this printer the default printer, select Yes; if not, select No and click Next 
(Windows 98/Me).

12. Select No to printing the Test Page and click Finish (98/Me).

The necessary PostScript files are installed to your computer.
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Configuring installed options
After you have completed the printer driver installation, you must configure the 
Fiery S300 for the options installed on the copier. This allows the Fiery S300 to take 
advantage of the copier options. You can configure the options manually. For TCP/IP 
network connections, you can also use the Two-Way Communication feature to 
configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the Fiery S300 for the 
options installed on the copier.

TO CONFIGURE OPTIONS MANUALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the Fiery S300 icon and choose Properties from the File menu. 

3. Click the Configuration tab.

4. Select an installed option from the Available Options list.

5. Click Add to move the option to the Installed Options list.
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Optional Tray—Not Installed, LCT 

Post Inserter—Not Installed, Post Inserter 

Trimmer Unit—Not Installed, Trimmer Unit 

Punch Kit—Not Installed, Punch Kit 

Document Feeder—Not Installed, Document Feeder 

GA Features—Not Installed, Installed

6. Click Apply, and then click OK.

Configuring installed options and updating print options 
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the copier. When the printer driver is 
first installed, the options have default settings that were set up in Fiery S300 Setup or 
ColorWise Pro Tools. When you update the printer driver with the Two-Way 
Communication feature, you allow the Fiery S300 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the Fiery S300. To access the Expert Color Settings 
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 
printing tab of your printer driver. For more information, see the Color Guide.

TO CONFIGURE INSTALLED OPTIONS AND UPDATE PRINT OPTIONS 
SETTINGS AUTOMATICALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the Fiery S300 PostScript printer driver. 

3. Choose Properties from the File menu.

4. Click the Configuration tab.
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5. Select Two-Way Communication.

6. Type the Fiery S300 IP address or DNS name.

7. To display the printer’s current default settings when opened, select Update Fiery 
Driver When Opened.

8. Click Update, and then click OK.

Completing the Windows 9x/Me printer connection
To print from Windows 9x/Me, you should already have set up network servers, if any, 
and set up the Fiery S300 to accept print jobs from your computer.

To complete the Windows 9x/Me connection, you must configure a connection on 
each Windows computer for the network.

Completing the Windows 9x/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 
be set up before you begin. The file server should be configured with a print server and 
print connection for the Fiery S300. For details, see your NetWare documentation and 
the Configuration Guide.
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To print from Windows 9x/Me computers over IPX (Novell), you must first set up 
IPX/SPX protocols, and then configure the Fiery S300 by choosing the IPX frame type 
and entering the settings for the port you use.

TO SELECT A FRAME TYPE FOR IPX/SPX PRINTING
FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the installed network 
components pane.

For instructions, see your Windows 9x/Me documentation or contact Microsoft 
Technical Support.

3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. Select Frame Type in the Property list. 
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6. In the Value menu, choose the Frame Type that corresponds to the one set in 
Fiery S300 Network Setup.

If necessary, print the Configuration page from the Fiery S300 Control Panel or the 
the Fiery Advanced Controller Interface to determine which frame type(s) 
are configured.

NOTE: Do not select Auto. Doing so may not select the frame type specified on 
the Fiery S300.

7. Click OK and close the Network Control Panel.

8. When prompted to restart your computer, click Yes.

TO SET UP A PORT FOR IPX (NOVELL) PRINTING WITH WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the Fiery S300 printer icon and choose Properties from the File menu.

3. Click the Details tab and click Add Port.

A list of connection options appears.

4. In the Add Port dialog box, specify the network path or click Browse for a display of 
your network environment.
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5. If you are using a NetWare file server, double-click the icon for the NetWare file server 
to use for printing to the Fiery S300.

6. Click the printer icon for the NetWare print queue you want to use, and then click OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server. 
The Fiery S300 polls the file server, and if jobs are present, they are transmitted to 
the Fiery S300.

8. To confirm the connection, click the General tab, click Apply, and then click Print 
Test Page.

After the Test Page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 9x/Me

SMB printing (also known as Windows or WINS printing) allows you to install the 
PostScript printer driver and printer description files on your computer from the 
Fiery S300 using Point and Print, and print to a particular connection (Hold, Print, or 
Direct). To set up SMB printing, you must have the TCP/IP protocol and Client for 
Microsoft Networks installed.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. Repeat the procedure “Setting up SMB printing with 
Windows 9x98/Me” for each connection. If you install more than one printer, give 
each a descriptive name during printer driver installation, such as Aero-Print or 
Aero-Hold, so you can easily identify printers.

BEFORE YOU BEGIN

• Print a Configuration page and check the setting for Enable SMB Print Services. 

NOTE: The default setting for Enable SMB Print Services on the Fiery S300 is Yes. 

To change the setting, right-click the FieryBar on the FACI and choose Setup Fiery to 
configure the Fiery S300, and then select Network Setup>Services>Windows Print 
Sharing (SMB)>Enable SMB Print Services.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.
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TO SET UP SMB PRINTING ON WINDOWS 9X/ME

1. Double-click the Network Neighborhood icon to display your network environment.

2. Browse for the printer you want to print to.

Browse for the name entered in Network Setup> Service Setup>Windows 
Setup>Server Name. For this information, see the Configuration page.

NOTE: You can also locate the printer using the Find feature on your Windows 
computer. Click Start, choose Find, and then choose Computer. Enter the name of the 
printer, and click Find Now.

If you are not able to locate your Fiery S300, contact your network administrator.

3. Double-click the name of the printer to display enabled print connections.

NOTE: For a description of each print connection, see the Configuration Guide.

4. Double-click the name of the connection you want to print to.

5. Select Yes to install the PostScript printer driver and printer description file for 
the selected connection.

The Add Printer Wizard dialog box appears.

6. Specify whether you print from MS-DOS based programs and click Next.

If you choose Yes, you must capture a printer port before proceeding with the 
installation. For details, see your Windows documentation.
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7. Type a name for the Fiery S300 in the Printer name field and choose whether to make 
it the default printer. Click Next.

8. If you want to print a Test Page, choose Yes and click Finish.

The necessary files are installed to your computer. 

If the Test Page prints successfully, you are ready to print from the computer.

Setting up IPP printing with Windows 9x/Me

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery S300 over 
the Internet.

IPP printing is supported on Windows 2000/XP but can be enabled on 
Windows 9x/Me computers by installing the “wpnpins.exe” client file (available on the 
Windows Me CD or the Windows 2000 Server CD). For more information about 
obtaining and installing this client, contact Microsoft Corporation or Microsoft 
Technical Support.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 
drivers (see “To install the PostScript or PCL printer driver for Windows 9x98/Me” on 
page 1-3).
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BEFORE YOU BEGIN

1. Prepare the Fiery S300 for TCP/IP printing.

2. Make sure the Fiery S300 is configured for IPP printing. 

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers windows, right-click the icon for the Fiery S300 PostScript printer 
driver and choose Properties.

3. Click the Details tab and click Add Port.

The Add Port dialog box appears.

4. Enter the network path for the printer.

The path for the printer is the IP address or the DNS name, followed by ipp, and then 
by the Fiery connection you want to print to (print, hold, or direct). Insert slashes 
between the elements, for example, http://10.10.10.150/ipp/print.

5. Click OK. 
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Setting up PostScript printing with Windows NT 4.0
To set up the Fiery S300 as a PostScript printer, you must install the PostScript printer 
driver for Windows NT 4.0 and the corresponding printer description files. You must 
also configure the print connection between the computer and the Fiery S300. If you 
are printing over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows NT 4.0
The following procedures describe the installation of a local printer. Adding a printer 
to a local system requires that you log in to your local Windows NT 4.0 computer 
(not the network server domain) and that you are a member of the Administrators 
group. The procedure for adding a network printer is similar to adding a port (see 
“Completing the Windows NT 4.0 TCP/IP and LPR connection” on page 1-49).

If you are printing using SMB on Windows NT 4.0, you can connect to the 
Fiery S300 and install the printer drivers in a single procedure; see “Setting up SMB 
printing on Windows NT 4.0” on page 1-54.

TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS NT 4.0

1. Insert the User Software CD into the CD-ROM drive.

2. Click Start, choose Settings, and then choose Printers.

3. Double-click Add Printer.



11-14 Installing User Software on a Windows Computer
4. To install a printer locally, select My Computer and click Next.

My Computer is available if you logged in to a computer on which you have 
Administrator privileges. If it is not available, you can only add a network printer. 
The procedure is similar to adding a port (see “Completing the Windows NT 4.0 
TCP/IP and LPR connection” on page 1-49).

5. Select LPT1: and click Next.

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.
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7. Type the name of the CD-ROM drive (for example, D:\) and click Browse.

If you are installing from files you downloaded using the Installer WebTool, type the 
name of your hard disk drive (for example, C:\) and click Browse.

8. Browse to the \Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

If you are installing from files you downloaded using the Installer WebTool, browse to 
the prntdrvr\Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

NOTE: Before you select the path name, you must first select your language.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install From Disk dialog box.

9. Verify that the path is correct and click OK.

10. Select the Fiery S300 50C-K as your printer and click Next.
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11. Type a name for the printer in the Printer name field and indicate whether you want to 
make it the default printer. Click Next.

12. Indicate whether you want the printer installed as a shared printer, and click Next.

If you select Shared, enter a Share Name for the printer and select the operating 
systems used by client computers. For information on shared printers, see the 
Configuration Guide.

13. Click No to postpone printing a Test Page and click Finish.

When installation is complete, the Printers window is displayed with an icon for the 
newly installed printer.
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You are ready for the instructions to connect to your network type (see “Completing 
the Windows NT 4.0 printer connection” on page 1-48).

Configuring installed options
After you have completed the printer driver installation, you must configure the 
Fiery S300 for the options installed on the copier. This allows the Fiery S300 to take 
advantage of the copier options. You can configure the options manually. For TCP/IP 
network connections, you can also use the Two-Way Communication feature to 
configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the Fiery S300 for the 
options installed on the copier.

TO CONFIGURE OPTIONS MANUALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the Fiery S300 icon and choose Properties from the File menu. 

3. Click the Configuration tab.
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Optional Tray—Not Installed, LCT 

Post Inserter—Not Installed, Post Inserter 

Trimmer Unit—Not Installed, Trimmer Unit 

Punch Kit—Not Installed, Punch Kit 

Document Feeder—Not Installed, Document Feeder 

GA Features—Not Installed, Installed

4. Click OK to activate the current settings.

You are now ready to connect to your network type (see “Completing the 
Windows NT 4.0 TCP/IP and LPR connection” on page 1-49).

Configuring installed options and updating print options 
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the Fiery S300. When the printer 
driver is first installed, the installable options have default settings that were set up in 
Fiery S300 Setup or ColorWise Pro Tools. When you update the printer driver with 
the Two-Way Communication feature, you allow the Fiery S300 to complete the 
actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the Fiery S300. To access Expert Color Settings 
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 
printing tab of your printer driver. For more information, see the Color Guide.

TO SET UP TWO-WAY COMMUNICATION FOR POSTSCRIPT 
PRINTER DRIVERS FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the Fiery S300 PostScript printer driver. 

3. Choose Properties from the File menu.
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4. Click the Configuration tab.

5. Select Two-Way Communication.

6. Enter the Fiery S300 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select 
Update Fiery Driver When Opened.

8. Click Update.

9. Click OK.
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Completing the Windows NT 4.0 printer connection
To print from Windows NT 4.0, you must:

• Set up network servers, if any.

• Set up the Fiery S300 to accept print jobs from your computer.

• Configure a port on each Windows NT 4.0 computer for the network type.

Completing the Windows NT 4.0 TCP/IP and LPR connection

After installing the PostScript printer driver and printer driver files, complete the setup 
for the TCP/IP and LPR connection by performing the following steps:

• Prepare the Fiery S300 to accept print jobs using TCP/IP and LPR protocols. 
For details, see the Configuration Guide.

• Enable LPD from the Fiery S300 Control Panel. For details, see the 
Configuration Guide.

• Enable LPD from the Fiery S300 Fiery Advanced Controller Interface. For details, 
see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to 
the Fiery S300, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on your Windows NT computer.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP 
and LPR connection” on page 1-49.

Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX 
(Novell) connection” on page 1-51.
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TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the Fiery S300 and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and 
Microsoft TCP/IP printing software. See your Windows documentation.

4. Type the IP address of the Fiery S300. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the Fiery S300 instead of the IP address.
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5. Type one of the following printer names, depending on the Fiery S300 connection you 
want to print to.

print
hold

NOTE: This name is case-sensitive; type it exactly as shown.

6. Click OK.

The computer checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must close the Printer 
Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.

10. Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 
the Fiery S300.

11. Click OK to close the Printer Properties dialog box.

Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery S300 print jobs. 
The file server should be configured with a print server and print connection for the 
Fiery S300. For details, see your NetWare documentation.

• Prepare the Fiery S300 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT 4.0 computer.
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TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the Fiery S300.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the Fiery S300.

5. If the NetWare server does not have a suitable driver for the Fiery S300, you may be 
asked if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the Fiery S300 PostScript printer driver.

7. Follow steps 6 to 18 of the procedure “To install the PostScript or PCL printer driver 
for Windows NT 4.0” on page 1-31.

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.
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8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 
the Fiery S300.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes window, type user and job identification information and 
click OK.

The Test Page remains listed in the queue window until it is printed.

The Fiery S300 polls the NetWare server for print jobs in the print connection defined 
for the Fiery S300. When you print, your PostScript files are spooled to that 
connection and transmitted over the queue “port” to the Fiery S300. 
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Setting up SMB printing on Windows NT 4.0

SMB printing (also known as Windows printing) allows you to install the PostScript 
printer driver and printer description files, and print from your computer to a 
particular print connection (Hold, Print, or Direct) on the Fiery S300. These 
instructions assume you have installed the TCP/IP protocol and Client for 
Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. To set up printing to a second or third print connection, repeat the 
procedure “To set up SMB printing on Windows NT 4.0” on page 1-56. If you install 
more than one printer, give each a descriptive name during printer driver installation, 
such as Aero-Print or Aero-Hold, so you can easily identify printers.

NOTE: If you set up SMB printing using Point and Print, to correctly specify Installable 
Options, install the printer driver from the User Software CD.

NOTE: To change printer defaults and configure installable options from Windows 
NT 4.0, you must log on as Administrator and use the password specified in 
Fiery S300 Setup. If you log on as a User, you can install the printer driver through 
Point and Print, but you cannot modify printer defaults and configure 
installable options.

BEFORE YOU BEGIN

• Print a Configuration page and check the setting for Enable SMB Print Services

NOTE: The default setting for Enable SMB Print Services on the Fiery S300 is Yes. 

To change the setting, right-click the FieryBar on the FACI and choose Setup Fiery to 
configure the Fiery S300. Then select Network Setup>Services>Windows Print Sharing 
(SMB)>Enable SMB Print Services.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.
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TO SET UP SMB PRINTING ON WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network 
Setup>Service Setup >Windows Setup>Server Name. For this information, see the 
Configuration page.

The amount of network traffic determines the amount of time required for the 
Browse function.

NOTE: You can also locate the printer with the Find feature on your Windows 
computer. Click Start, choose Find, and then choose Computer. Enter the name of the 
printer, and click Find Now.

If you are not able to locate your Fiery S300, contact your network administrator.

3. Double-click the name of the Fiery S300 to display enabled print connections.
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4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set up the printer.

5. Select Yes to complete the installation for the selected connection.

Windows NT 4.0 downloads the printer driver and printer description files from the 
Fiery S300 to your computer and installation is complete.

Setting up PostScript printing with 
Windows 2000/XP
To set up the Fiery S300 as a PostScript printer, you must install the PostScript printer 
driver for Windows 2000/XP and the corresponding printer description files. You 
must also configure the print connection between the computer and the Fiery S300. 
If you are printing over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows 2000/XP
The following procedure describes installing the printer driver from the User 
Software CD or from the Installer WebTool. Subsequent procedures describe setting 
up the print connection.

NOTE: To install the printer driver on a Windows 2000 computer, you must have 
Service Pack 3 installed on the computer. To install the printer driver on a Windows 
XP computer, you must have Service Pack 1 installed on the computer. Otherwise, a 
warning message alerts you to install the proper service pack after installation 
is complete.

NOTE: The following procedures use Windows 2000 illustrations; Windows XP, 
differences are noted. 
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TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers to display the 
Printers window. 
On Windows XP, click Start and choose Printer and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer under Printer Tasks.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 
connection later, according to your network type.

4. Select LPT1: and click Next.

5. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.
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6. Type the name of the CD-ROM drive (for example, D:\) and click Browse. Browse to the 
\Prntdrvr\Ps_drvr\Win_2000 or \Prntdrvr\Ps_drvr\Win_XP folder.

If you are installing from the files you downloaded using the Installer WebTool, 
browse to and click Open.

NOTE: Before you select the path name, you must first select your language.

Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open. 

7. Verify the path is correct and click OK.

The path is copied to the Install From Disk dialog box.

8. Select the Fiery S300 50C-K as your printer and click Next. 
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9. Type a name for the printer in the Printer name field.

This name will be used in the Printers window and the queues window.

10. Follow the instructions in the remaining dialog boxes.

When asked whether to print a Test Page, select No.

The necessary files are installed to your computer.

You are ready for the instructions to connect to your network type (see “Completing 
the Windows NT 4.0 printer connection” on page 1-48).

11. If this is the first printer driver you are installing on the computer, you may be 
prompted to install files from the Windows 2000 CD. Insert the CD-ROM, browse to the 
win2000\english\i386 folder, and then click OK.

When installation is complete, the Printers window appears with an icon for the newly 
installed printer. You must now configure the options installed on your copier.

Configuring installed options
After you have completed the printer driver installation, you must configure the 
Fiery S300 to reflect the options installed on the copier. This allows the Fiery S300 
to take advantage of the copier options. You can configure the options manually. 
For TCP/IP network connections, you can also use the Two-Way Communication 
feature to configure the options automatically.
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Configuring installed options manually

The following procedure describes how to manually configure the Fiery S300 for the 
options installed on the copier.

TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY S300 FROM THE 
POSTSCRIPT PRINTER  DRIVER FOR WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers. 
On Windows XP, click Start, and choose Printers and Faxes.

2. Right-click the Fiery S300 icon and choose Properties.

3. Click the Configuration tab.

4. Select an option from the Available Options list.

5. Click Add to move the option to the Installed Options list.
.

Optional Tray—Not Installed, LCT 

Post Inserter—Not Installed, Post Inserter 

Trimmer Unit—Not Installed, Trimmer Unit 

Punch Kit—Not Installed, Punch Kit 
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Document Feeder—Not Installed, Document Feeder 

GA Features—Not Installed, Installed

6. Click OK to activate the current settings.

You are ready to connect to your network type (see “Completing the 
Windows 2000/XP printer connection” on page 1-77).

Configuring installed options and updating print options 
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 
driver to reflect the options currently installed on the Fiery S300. When the printer 
driver is first installed, the installable options have default settings that were set up in 
Fiery S300 Setup or ColorWise Pro Tools. When you update the printer driver with 
the Two-Way Communication feature, you allow the Fiery S300 to complete the 
actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 
reflect the current color settings on the Fiery S300. To access the Expert Color Settings 
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 
printing tab of your printer driver. For more information, see the Color Guide.

SETTING UP TWO-WAY COMMUNICATION FOR POSTSCRIPT 
PRINTER DRIVERS FOR WINDOWS 2000/XP

NOTE: The procedures for setting up Two-Way Communication for the PostScript 
printer drivers on Windows 2000/XP are similar. The following procedure displays 
Windows XP illustrations. Differences are noted in the text.

NOTE: The following procedure displays Windows XP illustrations. Differences are 
noted in the text.

1. On Windows 2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start, and choose Printers and Faxes.

2. In the Printers window, select the icon for the Fiery S300 PostScript printer driver. 
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3. Choose Properties from the File menu.

4. Click the Configuration tab.

5. Select Two-Way Communication.
.

6. Enter the Fiery S300 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select the 
Update Fiery Driver When Opened option.

8. Click Update.

9. Click OK.
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Completing the Windows 2000/XP printer connection
To print from Windows 2000/XP, you must:

• Set up network servers, if any.

• Set up the Fiery S300 to accept print jobs from your computer.

• Configure a port on each Windows 2000/XP computer for the network type.

NOTE: The procedures for completing the printer connection for Windows 2000 and 
Windows XP are similar.

Completing the Windows 2000/XP TCP/IP and Port 9100 or LPR connection

After you have installed the PostScript and printer driver files, complete the setup 
for the TCP/IP and LPR connection as follows:

• Prepare the Fiery S300 to accept print jobs using TCP/IP and LPR protocols. 
For details, see the Configuration Guide.

• Enable LPD or Port 9100 from the Fiery S300 Control Panel. For details, see the 
Configuration Guide.

• Enable LPD or Port 9100 from the Fiery S300 Fiery Advanced Controller Interface. 
For details, see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to 
the Fiery S300, as well as the subnet mask and the gateway address, if they are used.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows 2000/XP TCP/IP and Port 
9100 or LPR connection” on page 1-79. 

Configure the IPX (Novell) 
connection

“Completing the Windows 2000/XP IPX (Novell) 
connection” on page 1-85.

Configure the IPP connection “Setting up IPP printing with Windows 2000/XP” on 
page 1-91.
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The TCP/IP protocol should already be installed on the Windows 2000/XP 
workstation.

NOTE: You can also set up the LPR connection by installing Print Services for UNIX, 
which is supplied as an add-on Windows component with your Windows 2000/XP 
CD. For more information, see your Windows documentation.

NOTE: The following procedures use Windows XP illustrations.

TO SET UP TCP/IP AND PORT 9100 OR LPR CONNECTION 
FOR WINDOWS 2000/XP

1. Open the Properties dialog box for the Fiery S300 and click the Ports tab.

2. Click Add Port. 
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3. Select Standard TCP/IP Port for Available port types and click New Port. 

4. Click Next. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

5. Type the IP address of the Fiery S300. 

6. Click Next.

7. Make sure that Generic Network Card is selected as Standard for Device Type and 
click Next.

8. Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box and click 
Close in the Printer Ports dialog box.
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9. Click Configure Port in the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.

10. If you have LPD printing enabled at the Fiery S300 Control Panel or Fiery Advanced 
Controller Interface, select LPR for Protocol and LPR Byte Counting Enabled under LPR 
Settings.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled under 
LPR settings.
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11. If you have Port 9100 printing enabled at the Fiery S300 Control Panel or Fiery 
Advanced Controller Interface, select Raw. 

The port number 9100 automatically appears under Raw Settings. This allows you to 
print to the printer connection that your administrator selected for Port 9100 printing 
in Fiery S300 Setup. You can also specify a port number as instructed in the next step.

12. Enter the name of the print connection.

For LPR, enter direct, print, or hold in the LPR Settings area.

For Port 9100, enter the port number corresponding to the print connection in the 
Raw Settings area:

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

13. Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.
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Completing the Windows 2000/XP IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery S300 print jobs. 
The file server should be configured with a print server and print connection for the 
Fiery S300. For details, see your NetWare documentation.

• Prepare the Fiery S300 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows 2000/XP computer.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS 2000/XP

NOTE: The following procedures use Windows 2000 illustrations.

1. On Windows 2000, double-click My Network Places.
On Windows XP, click Start, and then click My Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the Fiery S300.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the Fiery S300.
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5. If the NetWare server does not have a suitable driver for the Fiery S300, you may be 
asked if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the Fiery S300 PostScript printer driver.

7. Follow steps 6-10 of the procedure“To install the PostScript or PCL printer driver for 
Windows 2000/XP” on page 1-59.

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.

8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 
the Fiery S300.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes field, type user and job identification information, and then 
click OK.

The Test Page remains listed in the queue window until it is printed.

The Fiery S300 polls the NetWare server for print jobs in the print connection defined 
for the Fiery S300. When you print, your PostScript files are spooled to that 
connection and transmitted over the queue “port” to the Fiery S300.



11-41 Setting up PostScript printing with Windows 2000/XP
Setting up SMB printing on Windows 2000/XP

SMB printing (also known as Windows printing) allows you to install the printer 
driver and associated files, and print from your computer to a particular print 
connection (Hold, Print, or Direct) on the Fiery S300. These instructions assume you 
have installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 
description file. To set up printing to a second or third print connection, repeat the 
procedure, “To set up SMB printing on Windows 2000/XP”. If you install more than 
one printer, give each a descriptive name during printer driver installation, such as 
Aero-Print or Aero-Hold, so you can easily identify printers.

BEFORE YOU BEGIN

• To check the setting for Enable SMB Print Services, print a Configuration page. 

NOTE: The default setting for Enable SMB Print Services on the Fiery S300 is Yes. 

• To change the setting, right-click the FieryBar on the FACI and choose Setup Fiery to 
configure the Fiery S300. Then select Network Setup>Services>Windows Print Sharing 
(SMB)>Enable SMB Print Services.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 
and on the Configuration page. For more information, see the Configuration Guide.

TO SET UP SMB PRINTING ON WINDOWS 2000/XP

1. Open My Network Places.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup> 
Service Setup>Windows Print>Sharing (SMB)>Server Name. For this information, 
see the Configuration page.

The amount of network traffic determines the amount of time required for the 
Browse function.

NOTE: You can also locate the printer using the Search feature on your Windows 
computer. Right-click My Network Places and click Search for Computers. 
Type the name of the printer and click Search Now.
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If you are not able to locate your Fiery S300, contact your network administrator.

3. Double-click the name of the Fiery S300 to display enabled print connections.

You must now create a printer port and install the printer driver from the User 
Software CD.

NOTE: You cannot use Point and Print to install the driver and configure the printing 
connection to the Fiery S300 in a single procedure.

4. On Windows 2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

5. Double-click Add Printer and click Next.

6. Click Local Printer and click Next.

7. Click Create a New Port, and choose Local Port from the menu. Click Next.

8. In the Port Name dialog box, type the name of the Fiery S300, followed by the 
printing connection, and click OK.

Enter the port name as follows: \\Aero\print where Aero is the name of the Fiery S300 
and print is the printing connection.

9. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

You will now install the printer driver from the User Software CD.

10. Type the name of the CD-ROM drive and browse to the Prntdrvr\Ps_drvr\Win_2000 or 
Prntdrvr\Ps_drvr\Win_XP folder.

NOTE: Before you select the path name, you must first select your language.

11. Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open.

12. Verify the path is correct in the Install From Disk dialog box and click OK.

13. Follow the on-screen instructions.
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For more information, see “To install the PostScript or PCL printer driver for 
Windows 2000/XP” on page 1-59.

Setting up IPP printing with Windows 2000/XP

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery S300 over 
the Internet.

IPP printing is supported directly for Windows 2000/XPcomputers. IPP printing is 
not supported on Windows NT 4.0.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 
drivers (see “To install the PostScript or PCL printer driver for Windows 2000/XP” on 
page 1-59).

BEFORE YOU BEGIN

1. Prepare the Fiery S300 for TCP/IP printing.

For more information, see the Configuration Guide.

2. Prepare the Fiery S300 for IPP printing. 

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer under Printer Task.

3. Select Network printer and click Next.
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4. Select “Connect to a printer on the Internet or on your intranet.” Type an IP address 
or computer name in the URL field.

The URL for the printer is the IP address or DNS name followed by “ipp” and the 
connection you want to print to (print, hold, or direct). Insert slashes between the 
different elements.

5. Click Next.

The Connect to Printer dialog box appears.

6. Click OK.

The Add Printer Wizard dialog box appears. 

7. If you are installing the PostScript printer for Windows 2000/XP for the first time, 
follow the procedure described on page 1-59.

If you have already installed the printer driver on your computer, choose the 
appropriate names from the Manufacturers and Printers lists and click OK. 

8. Indicate whether you want to make the copier the default printer and click Next.

9. Click Finish.
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Installing Fiery utilities
From the User Software CD, you can install the following Fiery utilities and 
user software:

• ColorWise Pro Tools 

• Fiery Downloader

• Fiery Scan (TWAIN module)

• Fiery Remote Scan (TWAIN Fiery Scan Module and Application)

• EFI Fiery Mail Port 

• Fiery VDP Resource Manager

• Command WorkStation

Includes DocBuilder Pro. Acrobat 5.0.5 and PitStop, a plug-in for Adobe Acrobat

• Fiery Graphic Arts Package 

NOTE: Do not attempt to install DocBuilder Pro from the User Software CD (by 
starting the setup.exe from the DBPro folder); it is automatically installed when you 
install Command WorkStation. Installing DocBuilder Pro from the User Software CD 
can cause unpredictable results. In order to use DocBuilder Pro, you must install 
Acrobat v5.0.5 and the DocBuilder Pro dongle from the DocBuilder Pro Kit. To install 
Acrobat, see “Adobe Acrobat” on page 1-99.

The Fiery utilities must be separately installed on each user’s computer. 
The installation of each utility is similar. 

The Command WorkStation installer also installs the Java files necessary to use 
Fiery Setup from Command WorkStation. The Fiery Graphic Arts Package installer 
places a shortcut for Hot Folders on your Desktop.

To use Fiery S300 software as well as WebTools on Windows XP, you must install the 
“msjavx86.exe” file in the Java VM folder on your computer. For more information on 
WebTools, see the Job Management Guide and the Printing Guide.
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To install the software on a Windows 2000 computer, you must have Service Pack 3 
installed on your computer.

The TWAIN Fiery Scan and Fiery Remote Scan Module installer automatically creates 
a folder named Twain_32 in the Windows folder on your computer, and then installs 
the Fiery Remote Scan plug-in module into the folder.

NOTE: Before installing the TWAIN Fiery Scan or Fiery Remote Scan module, make 
sure the TWAIN plug-ins (installed with TWAIN-compliant application software) are 
located in the correct Plugins subfolder. If the TWAIN plug-ins have been deleted, you 
must reinstall the TWAIN-compliant application software in order to use Fiery Scan or 
Fiery Remote Scan.

You access the Fiery Scan or Fiery Remote Scan plug-in from the TWAIN-compliant 
software using the TWAIN module. For details, see the Printing Guide.

TO INSTALL FIERY UTILITIES

1. Open the appropriate folder for the software you want to install.

2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation.

BEFORE YOU BEGIN

• Print the Configuration page from the Fiery Advanced Controller Interface and note the 
IP address of the Fiery S300.

• Print the Configuration page from the Control Panel and note the IP address of 
the Fiery S300.
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Adobe Acrobat
In Command WorkStation, the DocBuilder Pro feature and PitStop software plug-in 
work with Adobe Acrobat v5.0.5. To use DocBuilder Pro, you must install Adobe 
Acrobat 5.0.5, the PitStop plug-in, and Command WorkStation. If you purchase the 
DocBuilder Pro option, the Acrobat software is included on the EFI DocBuilder Pro 
Kit CD.

NOTE: When your Fiery S300 is installed, a service technician typically sets up the 
system and installs Command WorkStation and DocBuilder Pro. If you see a software 
protection key (dongle) on the back of the Fiery S300, DocBuilder Pro has already 
been installed, and you can disregard the following section. If the dongle is not 
installed, refer to the instructions packaged with the dongle or see the 
following procedure.

NOTE: If Adobe Acrobat is installed after Command WorkStation, you may be required 
to restart Command WorkStation in order to use DocBuilder Pro. 

For more information about Adobe Acrobat for Windows, see the Readme.pdf file on 
the EFI DocBuilder Pro Kit CD.

TO INSTALL ACROBAT

NOTE: Log in to the Fiery S300 as Administrator and enter the password. For network 
security, the system administrator may change this password frequently. The default, 
case-sensitive password is “Fiery.1”.

1. Insert the EFI DocBuilder Pro Kit CD in the CD-ROM drive.

If a Windows screen appears asking “What do you want Windows to do?” either click 
Cancel or select “Open the folder to view files using Windows Explorer.”

2. Open the Acrobat folder, and double-click AutoPlay.exe.

Use only AutoPlay.exe. Do not navigate to the Setup folder or any of the language 
folders. Using setup.exe from these folders can result in an incomplete installation, 
which may cause system problems.

3. Follow the on-screen instructions.

All languages are installed.
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PitStop
PitStop is a plug-in for Adobe Acrobat 5.0.5 for use with DocBuilder Pro. You must 
first install Adobe Acrobat 5.0.5 as described in the previous section. PitStop software 
is included on the DocBuilder Pro Kit CD.

TO INSTALL PITSTOP

1. On the EFI DocBuilder Pro Kit CD, double-click to open the PitStop folder.

2. Open the PitStop folder and choose the setup icon for the language you want to 
install.

The Welcome to Enfocus PitStop Setup dialog box appears, 

3. Click Next and then click Yes to the license agreement.

The Information dialog box appears.

NOTE: Make sure to complete the Enfocus Certified PDF Personal Information form. 
Otherwise, the form will appear every time you launch Adobe Acrobat.

4. Click Next.

The Choose Destination Location dialog box appears. 

PitStop will automatically select the correct location for installation.

5. Click Next.

Setup is complete.

6. Click Finish.

For more information, see the PitStop documentation in Adobe Acrobat under 
Help>Plug-in Help\Enfocus PitStop Professional.
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Using Fiery utilities for the first time
Before you can use the newly installed software, you must configure the connection to 
the Fiery S300. Configuration of the Fiery utilities is similar. 

Configuring the connection for Fiery utilities

The first time you start one of the Fiery utilities, you must configure the connection to 
the Fiery S300. Similar configuration is used for all Fiery utilities, so any change in one 
configuration affects all the other connections. Configuration for most Fiery utilities is 
described in the following procedure. 

For configuration of specific Fiery utilities, see the following:

• “Configuring the connection for EFI Fiery Mail Port” on page 1-108

• “Configuring the connection for Command WorkStation” on page 1-116

• “Configuring the connection for Fiery VDP Resource Manager” on page 1-119

BEFORE YOU BEGIN

• Print the Configuration page from the Fiery S300 Fiery Advanced Controller Interface.

• Print the Configuration page from the Fiery S300 Control Panel.

This page contains information you need when configuring the connection, such as 
the IP address. For TCP/IP installations, you can use the DNS name of the Fiery S300 
instead of the IP address. Make sure the Fiery S300 is already registered in a Domain 
Name Server (DNS) on your network. For more information, see your Windows 
system documentation. 
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TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1. Start the utility for which you want to configure a connection. 

For Fiery Scan or Fiery Remote Scan, start the supported TWAIN-compliant software.

For details, see the Printing Guide.

2. If the No Servers Configured dialog box appears, click OK.

If the Choose Printer Device dialog box appears, click Add.

3. Enter the appropriate information for the Fiery S300.

Nickname—Enter a name for the Fiery S300. This name does not have to match the 
actual Server Name of the Fiery S300.

NOTE: The nickname cannot contain the following characters:
[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the menu.

NOTE: Fiery utilities are not supported over IPX/SPX. Command WorkStation is 
supported on Windows computers over TCP/IP, and on the Fiery Advanced 
Controller Interface over the PIPE protocol.

Server Name—Enter the IP address (or DNS name) of the Fiery S300.
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New Device—Enter the name of the device the Fiery S300 is connected to: 50C-K.

NOTE: Type 50C-K exactly as shown because this term is case-sensitive.

4. When you have entered all the information, click Add.

5. With the device name (50C-K) selected in the Devices list, click OK.

The Fiery S300 appears in the list of Available Servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol you chose. 
The second line displays the device name. 

6. With the device name selected in the list of Available Servers, click Select to begin 
using the utility.

Modifying the configuration

Edit the configuration whenever there is any change to your Fiery S300 server or 
network, such as a server name or IP address. If you change Fiery S300 Setup 
information, do so before reconfiguring the connection.

TO MODIFY THE CONFIGURATION

1. To edit information for a Fiery S300 in the list of available servers, select the 
Fiery S300 by its nickname and click Modify. 

2. Make the necessary changes in the Modify Server Settings dialog box and click OK. 

Device name of the 
Fiery S300 (50C-K)
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3. To add a new Fiery S300 to the list of available servers, click Add. Configure the Add 
New Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove an Fiery S300, select the Fiery S300 by its nickname and click Remove.

NOTE: The nickname cannot be modified.

Configuring the connection for EFI Fiery Mail Port
The E-Mail Service provides a method to print and control the Fiery S300 remotely. 
Jobs are sent to the Fiery S300 in the form of e-mail attachments. You can set up 
e-mail printing on Windows computers by adding the EFI Fiery Mail Port software 
as a printer port.

To set up the Fiery S300 for e-mail printing, see the Configuration Guide. After Setup 
has been performed, install the software from the User Software CD onto your 
Windows computer, and then add a port.

NOTE: Procedures are given for Windows 9x/Me and Windows NT 4.0/2000/XP.

TO INSTALL THE E-MAIL PORT MONITOR ON WINDOWS COMPUTERS

1. Open the EFI Fiery Mail Port folder on the User Software CD.

2. Double-click the Setup icon and follow the on-screen instructions.

When installation is complete, you are ready to configure the connection for the e-mail 
port monitor.

TO CONFIGURE THE CONNECTION FOR EFI FIERY MAIL PORT ON 
WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, right-click the icon for the Fiery S300 printer driver.

For instructions on installing the printer driver, see “Installing the PostScript or PCL 
printer driver for 9x98/Me” on page 1-3.
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3. Choose Properties, and click the Details tab.

4. Click Add Port.

5. Click Other and select EFI Fiery Mail from the list of ports.

6. Click OK.

7. Enter the basic information required to set up the e-mail port. 

Fiery’s E-mail Address—Enter the e-mail address of the Fiery S300.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port 
monitor to use.
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8. Click Advanced.

The E-Mail Port Configuration dialog box appears.

9. Enter the following information.

For Fiery Server:

E-mail Address—The e-mail address of the Fiery S300.

Queue—The print connection on the Fiery S300 that you want.

For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.

For Options:

Break apart messages larger than—The maximum size of a single e-mail message 
is displayed. If a job exceeds this size, it is split into multiple messages, each not 
exceeding this size, and is sent to the Fiery S300. The Fiery S300 then automatically 
combines all split messages into the original single print job for printing.

Status messages from Fiery—When enabled, the Status option requests the Fiery S300 
to send status reports of the job via e-mail.
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10. Click OK.

11. Click Apply, and then click OK.

The connection for the EFI Fiery Mail Port has now been configured.

TO CONFIGURE THE CONNECTION FOR THE EFI FIERY MAIL PORT
ON WINDOWS NT 4.0/2000/XP

1. On Windows NT 4.0/2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

2. On Windows NT 4.0/2000, In the Printers window, double-click the Add Printer icon 
and click Next.

On Windows XP, in the Printers and Faxes window, click Add a printer and click Next.

3. Specify printing using a Local printer and click Next.

4. In the window displaying a list of ports, click Add Port.

The Printer Ports dialog box is displayed, with the EFI Fiery Mail port listed as one of 
the available ports. 
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5. Select EFI Fiery Mail and click New Port. 

The Add Port dialog box appears.

6. Enter the basic information required to set up the e-mail port. 

Fiery’s E-mail Address—Enter the e-mail address of the Fiery S300.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port 
monitor to use.

7. Click Advanced.

The E-Mail Port Configuration dialog box appears.
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8. Enter the following information.

For Fiery Server:

E-mail Address—The e-mail address of the Fiery S300.

Queue—The print connection on the Fiery S300 that you want.

For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.

For Options:

Break apart messages larger than—The maximum size of a single e-mail message 
is displayed. If a job exceeds this size, it is split into multiple messages, each not 
exceeding this size, and is sent to the Fiery S300. The Fiery S300 then automatically 
combines all split messages into the original single print job for printing.

Status messages from Fiery—When enabled, the Status option requests the Fiery S300 
to send status reports of the job via e-mail.

9. Click OK.

The Add Printer Wizard dialog box appears.

10. Click Next and follow the instructions for installing the printer driver for your 
Windows computer.
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Configuring the connection for Command WorkStation
The first time you start Command WorkStation, you are prompted to configure the 
connection to the Fiery S300.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1. Print a Configuration page.

The information on this page helps you locate the Fiery S300, if it is not on the same 
local subnet as your computer.

2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the local subnet 
are displayed. 

3. If no Fiery S300 servers were found, click the Manual tab to search by DNS name
or IP address. Click Add to add the server to the Available Servers list.
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4. Click the Auto Search tab and then click Advanced to search by either a range of 
IP addresses or the IP address and subnet mask. 

5. Click Search.

All available servers appear in the Available Servers list.

6. Select the Fiery S300 server you want to use and click Add.

The selected Fiery S300 appears in the Login Server dialog box.
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7. Click the server name.

The Login dialog box appears.

8. Select Administrator, Operator, or Guest and click Log In. When prompted, enter the 
password.

Your computer is connected to the Fiery S300.

Modifying the configuration

Edit the configuration whenever there is any change to your Fiery S300 server or 
network, such as a server name or IP address. If you change Fiery S300 Setup 
information, do so before reconfiguring the connection.

TO MODIFY THE CONFIGURATION

1. Start Command WorkStation.

The Login Server window appears.

2. Select the Fiery S300 server for which you want to modify the configuration, and 
click Remove.

3. To add the modified Fiery S300 server, follows steps 3 through 6 of the 
previous procedure.

To modify the connection to the Fiery S300, you must remove the server from the 
Login Server list and follow the procedure for configuring the connection.
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Configuring the connection for Fiery VDP Resource Manager
The Fiery VDP Resource Manager allows you to view and delete all global objects used 
in variable data printing. For more information, see the Printing Guide.

TO CONFIGURE THE CONNECTION FOR FIERY VDP RESOURCE MANAGER

1. Click Start, choose Programs, and then click Fiery VDP Resource Manager in the 
Fiery folder.

The Available Servers dialog box appears with all Fiery S300 servers in the local 
subnet displayed.
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2. To locate a server by its IP address, click the Manual tab. Enter the IP address and 
click Add.

The server appears in the Available Servers dialog box.

3. To locate the Fiery S300 either by a range of IP addresses or by the IP address and 
subnet mask, click the Auto Search tab and then click Advanced.

4. Click the IP Range tab or the Subnet tab.
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5. To search by a range of IP addresses, enter the information in the From IP and 
To IP fields. Click Add and then click Search.

To search by IP address and subnet mask, enter the information in the From IP and 
Subnet fields. Click Add and then click Search.

All available servers will be displayed in the Available Servers dialog box.

6. Select the servers you want and click Add.

All connected servers are displayed in the Fiery Servers list in the Fiery VDP Resource 
Manager dialog box.

To use the Fiery VDP Resource Manager, see the Printing Guide.

TO MODIFY THE CONFIGURATION FOR FIERY VDP RESOURCE MANAGER

1. Click Start, choose Programs, and then click Fiery VDP Resource Manager in the 
Fiery folder.

All servers you connected to previously are displayed.

2. To remove a server, choose Disconnect from the Server menu.

3. To add a server, choose Connect from the Server menu and follow the procedure“To 
configure the connection for Fiery VDP Resource Manager” on page 1-119.
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Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your computer. 
Many of the files are PostScript files that you can download and print using 
Fiery Downloader.

Icc folder ICC monitor settings file and a device profile specially designed 
for use with the Fiery S300 and the copier. For instructions on 
installing, see “Installing the ICM ICC profiles on a Windows 
computer” on page 1-128.

Clrfiles folder 
(inside the 
English folder)

Cmyk.ps, an 11-page, letter-size PostScript file to use for 
reference when defining CMYK colors in applications.

Pantone.ps, a 19-page, letter-size PostScript file that indicates the 
closest equivalent of PANTONE coated colors that the 
Fiery S300 and your copier model can produce. The method 
used to print the Pantone.ps file differs depending on the Spot 
Color Matching setting. For more information, see the 
Printing Guide and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 97 or 
later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to 
view available RGB colors.

Calibrat folder
(inside the 
English\Clrfiles 
folder)

Four PostScript files of color patches for obtaining 
measurements: Custom21.ps, Custom34.ps, Stand21.ps, and 
Stand34.ps. The numbers in the file names refer to the number 
of patches on the page. The Custom files allow you to download 
measurement patches that incorporate the current calibration set 
of the copier. The Standard files allow you to download standard 
measurement patches that bypass the current calibration set of 
the copier. For information on using these files, see 
the Color Guide.

NOTE: These files are provided for expert users and should not be 
used for day-to-day calibration.
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Installing the ICC profiles on a Windows computer

The ICC profiles included in the Icc folder on the User Software CD are for use 
with ColorWise Pro Tools. You can also use the ICC profiles with applications that 
support ICC standards, such as Photoshop. For most ICC-aware applications, the files 
must be installed in a folder named Color in the System Folder. For use with 
ColorWise Pro Tools, you can copy the files to a folder of your choice. 

You can upload additional ICC profiles with the Profile Manager in ColorWise Pro 
Tools. For more information on uploading and using ICC profiles with ColorWise Pro 
Tools, see the Color Guide.

TO INSTALL THE ICC PROFILES ON A WINDOWS COMPUTER

1. On the User Software CD, open the Icc folder.

2. If you are using Windows 9x/Me, copy the profiles to the Windows\System\Color 
folder on your computer.

If you are using Windows NT or Windows 2000, copy the profiles to the 
Winnt\System32\Color folder on your computer.

NOTE: If a folder named “Color” does not exist in the System32 folder, create one and 
install the profiles into it.

If you are using Windows XP, right-click the profile you want and click Install Profile.

NOTE: The profiles are installed automatically to the 
Windows\System32\spool\drivers\color folder on your computer. 

Loading the monitor settings file
The Efirgb.icc monitor settings file can be used in Photoshop, or other applications 
that support ICC profiles, to define a source color space for printing to the Fiery S300.

These instructions assume you have installed the ICC profiles included on the 
User Software CD. For more information, see the preceding section.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

NOTE: If you use Fiery Remote Scan, install the monitor settings profile.
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TO LOAD THE RGB WORKING SPACE PROFILE MONITOR SETTINGS 
FILE FOR PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from the Color 
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. For Windows 9x/Me, browse to the Windows\System\Color folder, select Efirgb.icc, and 
then click Load.

For Windows NT 4.0 or Windows 2000, browse to the Winnt\System32\Color folder, 
select Efirgb.icc, and then click Load.

For Windows XP, browse to the Windows\System32\spool\driver\color folder, select 
Efirgb.icc, and then click Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup dialog box.

5. Click OK.
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For more information about ICC profiles, see your Photoshop documentation.

Loading the ICC copier device profile
This ICC profile defines the target color space for printing to the copier.

These instructions assume you have installed the ICC profiles included on the 
User Software CD. For more information, see “Installing the ICM ICC profiles on a 
Windows computer” on page 1-128.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

TO LOAD THE ICC COPIER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery S300 from the Profile menu.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.
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Loading monitor settings files and ICC copier device profiles in 
Photoshop 6.x/7.x

After you have installed the Efirgb.icc monitor settings file and the ICC profile for the 
Fiery S300, they can be loaded at the same time in Photoshop 6.x/7.x.

TO LOAD THE MONITOR SETTINGS FILE AND ICC COPIER DEVICE 
PROFILE IN PHOTOSHOP 6.X/7.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and select Advanced Mode in the Color 
Settings dialog box.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the Fiery S300 from the CMYK menu.

5. Click OK.

For more information, see your application’s documentation. 

Installing the printer description files for Windows
The User Software CD contains printer description files for popular Windows 
applications. Adobe Pagemaker 6.x and 7.x do not support automatic installation of 
printer description files from the Printers or Printers and Faxes Control Panel. To make 
the Fiery S300 available in the Print and Page Setup dialog boxes of this application, 
copy printer description files to the appropriate location.

TO COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder 
that corresponds to the language system you are using.

For Windows 9x/Me, select \Prntdrvr\Ps_drvr\Win_9x_ME.

For Windows NT 4.0, select \Prntdrvr\Ps_drvr\Win_NT4x.

For Windows 2000, select \Prntdrvr\Ps_drvr\Win_2000.

For Windows XP, select \Prntdrvr\Ps_drvr\Win_XP.
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2. Copy the printer description file for your Fiery S300 to the appropriate location.

If you use Copy this file To this location

PageMaker 6.5.2/7.0 EF4M7U10.PPD For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4
For PageMaker 7.0,
\PM7\RSRC\USENGLSH\PPD4
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The general steps for installing the Fiery S300 user software and setting up printing 
on a Mac OS computer are as follows:

• Install the PostScript printer driver and printer description file.

• Set up the Fiery S300 in the Chooser.

• Install the Fiery utilities (Fiery Scan, Fiery Remote Scan, ColorWise Pro Tools, 
Fiery Downloader, Command WorkStation LE, Fiery VDP Resource Manager, and 
Fiery Spooler).

• Configure the connection for Fiery utilities.

• Install the printer and screen fonts.

• Install the ColorSync profiles.

• Install additional color reference and application-specific files.

In addition to using the User Software CD, you can download printer drivers from the 
Fiery S300 with the Installer WebTool (if the site administrator has enabled Internet 
access to the Fiery S300). For instructions, see “Using the Fiery WebTools Installer” on 
page 3-2.

Once you download the printer files, the installation process is identical to installing 
from the User Software CD.

Setting up the Fiery S300 as a PostScript printer
To set up the Fiery S300 as a PostScript printer, you must install the PostScript printer 
driver and the printer description file that corresponds to your copier. The PostScript 
printer driver and printer description files are provided on the User Software CD. 
Printer drivers provide a way to communicate information on print jobs between your 
applications, the Fiery S300, and any other PostScript printer connected to 
your computer.

When you install printer files from the User Software CD or printer files downloaded 
using the Installer WebTool, use the following procedures.

Chapter 2:
Installing 
User Software 
on a Mac OS 
Computer
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Setting up Mac OS 9 printer drivers and printer description files
The following instructions describe how to set up printer drivers and printer 
description files.

TO INSTALL THE ADOBEPS PRINTER DRIVER AND PRINTER  
DESCRIPTION FILE FOR MAC OS 9

1. Quit all open applications.

After you have completed installation, restart your computer.

2. On the User Software CD, open OS9 folder and then the English: Printer Driver folder.

If you are installing from files you downloaded using the Installer WebTool, open the 
Printer Driver folder on your hard disk.

3. Double-click the AdobePS Installer icon.

4. Follow the on-screen instructions.

The AdobePS Installer installs the Adobe PostScript printer driver, and the printer 
description file that corresponds to the Fiery S300.

NOTE: If you operate the Fiery S300 in a copy shop, quick print shop, or service 
bureau, provide your customers with copies of the printer driver, printer description 
file, or ICC profiles you use for printing images, as well as any relevant documentation. 
This ensures that jobs they create and print to files are properly formatted for printing 
to the Fiery S300.
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Setting up the Fiery S300 in the Chooser

After you install the Adobe PostScript printer driver and printer description file (see 
“Setting up the Fiery S300 as a PostScript printer” on page 2-1), you must set up the 
Fiery S300 in the Chooser in order to take full advantage of its features. This section 
describes how to set up the Fiery S300 with the AdobePS printer driver.

NOTE: It is recommended that you set the Multiple Users function to Off.

TO SET UP THE FIERY S300 IN THE CHOOSER

1. Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.

3. Click the AdobePS icon.

The Fiery S300 appears in the Select a PostScript Printer list in the form of 
<server name>_<print connection>. 

NOTE: Only the print connections (Direct, Hold, and Print) that have been enabled 
in Setup appear in the Chooser. 
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4. Select a Fiery S300 connection from the “Select a PostScript Printer” list 
and click Create.

Select the correct printer description file for your printer.

NOTE: You must set up each print connection separately. Repeat this step for all 
enabled connections.

5. With the same printer selected, click Setup, and then click Configure.

6. In the Installable Options dialog box, select the appropriate settings from the menus 
and click OK.

Optional Tray—Not Installed, LCT 
Post Inserter—Not Installed, Post Inserter 
Trimmer Unit—Not Installed, Trimmer Unit 
Punch Kit—Not Installed, Punch Kit 
Document Feeder—Not Installed, Document Feeder 
GA Features—Not Installed, Installed

7. Click OK to close options for the printer.

8. Close the Chooser.



22-5 Setting up the Fiery S300 as a PostScript printer
Setting up Mac OS X v10.2 printer drivers and printer 
description files
The following instructions are for Mac OS X v10.2 and above Native mode. 

The User Software CD contains the following software for Mac OS X v10.2 inside the 
OSX folder:

• PPD Installer—this application installs the PostScript Printer Description files 
(PPDs) necessary to print from Mac OS X v10.2. It also installs the (Fiery Job 
Notes) FJN module.

• Language folders—these folders contain copies of the printer description files that 
will be installed by the PPD Installer. You do not need to open these folders or install 
them manually on your computer; the appropriate files will be installed by the 
PPD Installer.

TO INSTALL THE PRINTER DESCRIPTION FILES FOR MAC OS X V10.2

NOTE: Fiery utilities as well as Fiery WebTools are not supported on Mac OS X v10.2.

1. Quit all open applications.

2. Make sure that Print Center is not running on your computer.

Print Center updates the list of available printers when it restarts; if a printer 
description file is added while Print Center is running, you cannot select the associated 
printer model until you restart Print Center.

3. Insert the User Software CD into the CD-ROM drive.

4. Open the Printer Driver folder inside the OSX folder on the User Software CD.

5. Click the PPD Installer icon to start installing printer description files.

6. Follow the on-screen instructions.

The PPD Installer installs the printer description files that correspond to 
the Fiery S300.

After you have completed installation, restart your computer.
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Setting up the Fiery S300 in the Print Center

After you install the printer description files, you must set up the Fiery S300 in the 
Print Center in order to take full advantage of its features. This section describes how 
to set up the Fiery S300 and configure installable options. The PPD Installer installs all 
language files at the same time. The following procedures describe how to set up the 
Fiery S300 on a system using either English or a non-English language.

TO SET UP THE FIERY S300 IN THE PRINT CENTER ON AN 
ENGLISH SYSTEM

1. Double-click Print Center in ‘Utilities’ under Startup disk/Applications. 

2. Click Add in the Printer List dialog box.

3. Choose AppleTalk or IP printing in the pop-up menu.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the 
Fiery S300.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select 
AppleTalk Network, select the zone, and click Choose.
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For IP Printing, enter the IP address or DNS name of the printer for Printer’s Address, 
clear Use default queue on server, and then enter the print connection for 
Queue Name.

NOTE: Enter the printer Queue Name for the print connection. You cannot use the 
same Queue Name for more than one printer. 

5. For Printer Model, select the appropriate manufacturer name, and then select the file 
for the Fiery S300 PPD. 

6. Click Add.

7. Proceed to “To configure installable options” on page 2-10.

TO SET UP THE FIERY S300 IN THE PRINT CENTER ON A 
NON-ENGLISH SYSTEM

1. Double-click Print Center in ‘Utilities’ under Startup disk/Application. 
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2. Click Add in the Printer List dialog box.

3. Choose AppleTalk or IP printing in the pop-up menu.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the 
Fiery S300.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select 
AppleTalk Network, select the zone, and click Choose.

For IP Printing, enter the IP address or DNS name of the printer for Printer’s Address, 
clear Use default queue on server, and then enter the print connection for 
Queue Name.

NOTE: Enter the printer Queue Name for the print connection. You cannot use the 
same Queue Name for more than one printer.
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5. For Printer Model, select Other.

6. In the Choose a File dialog box, select the appropriate language file from the left 
column, and the Fiery S300 name from the right column. 

The following table explains which file name corresponds to your language.

NOTE: These files are located on your hard drive in System Folder:Library:Printers: 
PPDs:Contents:Resources.

7. Click Choose.

8. Click Add in the Printer List window.

For more information about adding printers, see your Mac OS X documentation.

Language File name

Dutch nl.lpro

English en.lproj

French fr.lproj

German de.lproj

Italian it.lproj

Japanese ja.lproj

Portuguese pt.lproj

Spanish es.lproj

Swedish sv.lproj
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TO CONFIGURE INSTALLABLE OPTIONS

1. Double-click Print Center in ‘Utilities’ under Startup disk/Applications. 

2. Select your printer in the Printer List.

3. Choose Show Info from the Printer menu.

4. Choose Installable Options in the pop-up menu.

5. In the Printer Info dialog box, choose the appropriate settings.

Optional Tray—Not Installed, LCT 

Post Inserter—Not Installed, Post Inserter 

Trimmer Unit—Not Installed, Trimmer Unit 

Punch Kit—Not Installed, Punch Kit 

Document Feeder—Not Installed, Document Feeder 

GA Features—Not Installed, Installed
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6. Click Apply Changes and close the dialog box.

Installing Fiery S300 software and fonts
The Mac OS installers function essentially the same for each type of software. Before 
you begin each installation, determine where you want to install each item on your 
hard disk. Otherwise, the software is placed by default as follows:

• ColorSync profiles—ColorSync Profiles folder.

If you are using ColorSync 2.5, install the profiles into the ColorSync Profiles folder 
inside the System Folder. If you are using an earlier version of ColorSync, install the 
profiles to the ColorSync Profiles folder inside the SystemFolder:Preferences folder. 
The printer profile can be moved to a folder of your choice.

• Fiery Downloader, Fiery Spooler, Fiery VDP Resource Manager, ColorWise Profiler, 
and ColorWise Pro Tools—“Fiery” folder.

• Fiery Scan—Supported TWAIN-compliant application software Plug-Ins folder.

The installer also creates a folder named TWAIN in your System folder:Preferences 
folder, and installs a Fiery Scan module and Source Manager file into that folder. 

• Fonts—System Folder:Fonts folder.

For instructions on installing Fonts, see “Fonts” on page 2-25.

TO INSTALL MAC OS SOFTWARE

1. Insert the User Software CD in the CD drive and double-click the Installer icon of the 
item you want to install, then follow the instructions in the installer dialog boxes.

2. If prompted, click Quit to close the software installer.

TO UNINSTALL MAC OS SOFTWARE

1. Locate the System Folder on your hard disk.

2. Inside the Extensions folder, locate MRJ Libraries and remove it or move it to another 
folder.

3. Inside the Apple Extras folder, locate Mac OS Runtime Java, and remove it or move it 
to another folder. 
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4. Restart your computer

In order to use ColorWise Pro Tools or Fiery Spooler, you must have Mac OS Runtime 
for Java (MRJ) installed on your computer.

If you do not have the appropriate MRJ installed, the installer automatically initiates 
the MRJ installation process.

5. To Install MRJ, follow the instructions in the installer dialog boxes.

Installing MRJ on your computer

If you do not have MRJ installed, the ColorWise Pro Tools, Fiery Remote Scan, or 
Fiery Downloader installer automatically initiates the MRJ installation process.

NOTE: The respective installer prompts the MRJ installation from the User Software 
CD. MRJ 2.2.5 is provided on the User Software CD.

TO INSTALL MAC OS RUNTIME FOR JAVA

1. Open the MRJ folder on the User Software CD and double-click Installer.

2. Read the Apple Computer Inc. License Agreement and click Agree to install 
the software.

3. Click Install.

Some files are installed.

4. Click Quit.

You are now ready to configure the ColorWise Pro Tools and Fiery Spooler 
connections to the Fiery S300.

We recommend that you use the version of MRJ provided on the User Software CD 
with the Fiery S300 software.
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Configuring a connection for ColorWise Pro Tools
The first time you use ColorWise Pro Tools, you are prompted to configure a 
connection to the Fiery S300.

NOTE: ColorWise Pro Tools are supported only over TCP/IP networks. 

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 
the Fiery S300.

• Print the Configuration page from the Fiery Advanced Controller Interface and note the 
IP address of the Fiery S300.

TO CONFIGURE A CONNECTION FOR COLORWISE PRO TOOLS

1. Start the utility by double-clicking its icon.

The Choose Printer Device dialog box appears.
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2.  If you have previously configured a connection to the Fiery S300, you are ready to use 
ColorWise Pro Tools. If you have not configured a connection, click Add.

3. Enter the appropriate information for the Fiery S300.

Nickname—Enter a name for the Fiery S300. It does not have to match the actual 
server name of the Fiery S300.

NOTE: The nickname cannot contain the following characters:
[ ] _ " ' <space> <tab>

Protocol—TCP/IP is the only supported network protocol, so no selection is necessary.

Server Name—Enter the IP address (or DNS or hosts name) of the Fiery S300.

New Device—Enter the name of the device the Fiery S300 is connected to: 50C-K. 
This device name appears in the Printer Setup section of the Configuration page.

NOTE: The device name is case sensitive; enter it exactly as it appears here.

4. When you have added all the information, click Add.

5. With the device name selected in the Devices list, click OK.

The Fiery S300 appears in the list of Available Servers. The first line of the entry 
displays the nickname you gave the server, followed by the protocol. The second line 
displays the device name.
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6. With the device name selected in the list of Available Servers, click Select to begin 
using ColorWise Pro Tools.

Modifying the configuration

Edit the configuration whenever there is any change to your Fiery S300 or network, 
such as an IP address or device change. Change the specific Fiery S300 Setup 
information before configuring the connection. 

TO MODIFY THE CONFIGURATION

1. In the Chooser dialog box, click Option.

2. To edit information for a Fiery S300, select the Fiery S300 by its IP address or DNS 
name and click Modify. Edit information in the Settings dialog box as necessary, and 
click OK.

3. To add a new Fiery S300, click Add. Configure the Settings dialog box as outlined in 
steps 3 through 5 in the preceding procedure.

4. To remove an Fiery S300, select the Fiery S300 by its IP address or DNS name, and 
click Remove.

The list of Available Servers reflects the modifications you have made.

Device name of the Fiery S300
(50C-K)
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Configuring a connection for Fiery Spooler

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 
the Fiery S300.

• Print the Configuration page from the Fiery Advanced Controller Interface and note the 
IP address of the Fiery S300.

TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER

1. Start the utility by double-clicking its icon.

The Chooser dialog box appears.

2. Click Option.

3. Click Add.

4. Enter the appropriate information for the Fiery S300.
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Name—Enter the IP address (or DNS name) of the Fiery S300.

New Device—Enter the name of the device that the Fiery S300 is connected to: 50C-K. 
This device name appears in the Printer Setup section of the Configuration page.

NOTE: Type 50C-K exactly as shown; this term is case-sensitive.

5. When you have entered all the information, click Add.

6. With the device name selected, click OK.

The Fiery S300 appears in a list of configured servers.

7. Click OK in the Configure dialog box.

The Fiery S300 appears in a list of Available Servers.

8. With the Fiery S300 selected in the list of Available Servers, click OK to begin using 
Fiery Spooler.

Fiery S300 name and device 
name (50C-K)

Fiery S300 name and device 
name (50C-K)
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Modifying the configuration

Edit the configuration whenever there is any change to your Fiery S300 or network, 
such as an IP address or device change. Change the specific Fiery S300 Setup 
information before configuring the connection.

TO MODIFY THE CONFIGURATION

1. In the Chooser dialog box, click Option.

2. To edit information for an Fiery S300, select the Fiery S300 by its IP address or DNS 
name and click Modify. Edit information in the Settings dialog box as necessary, and 
click OK. 

3. To add a new Fiery S300, click Add. Configure the Settings dialog box as outlined in 
steps 3 through 6 in the preceding procedure.

4. To remove a Fiery S300, select the Fiery S300 by its IP address or DNS name, and 
click Remove. 

The list of Available Servers reflects the modifications you have made.

Configuring the connection for Fiery Downloader 
and Command WorkStation LE for Mac OS X
The first time you start Fiery Downloader or Command WorkStation LE, you are 
prompted to configure the connection to the Fiery S300.

BEFORE YOU BEGIN

• Print the Configuration page from the Fiery Advanced Controller Interface and note the 
IP address of the Fiery S300.

• Print the Configuration page from the Control Panel and note the IP address of 
the Fiery S300.

TO SPECIFY A FIERY S300 CONNECTION

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the Fiery S300 is located from the AppleTalk 
Zones list.
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The available servers appear in the Servers list.

3. Select the Fiery S300 in the Servers list.

4. Click Connect.

The Fiery Downloader dialog box appears.

For information on how to use Fiery Downloader, see the Printing Guide.

Fiery S300 name and device name
(50C-K)
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TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION LE

1. Print a Configuration page.

The information on this page helps you locate the Fiery S300 if it is not on the same 
local subnet as your computer.

2. Start Command WorkStation LE.

The Available Servers dialog box is displayed. All servers found in the local subnet 
are displayed. 

NOTE: The device name for the Fiery S300 is 50C-K.

3. If no Fiery S300 servers were found, click the Manual tab to search by DNS name or 
IP address. Click Add to add the server to the Available Servers list.
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4. If no Fiery S300 servers were found, click the Auto Search tab and then click Advanced 
to search by either a range of IP addresses or the IP address and subnet mask. 

5. Click Search.

6. Select the Fiery S300 server you want to use and click Add.
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The selected Fiery S300 server is displayed in the Login Server dialog box.

7. Click the server name.

The Log In dialog box is displayed.

8. Select a key for Administrator, Operator, or Guest and click Log In.

9. If prompted, enter the password for Administrator or Operator. 

Your computer is connected to the server.

To modify the Command WorkStation LE connection to the Fiery S300, you must 
remove the server from the Login Server list and follow the procedure for configuring 
the connection.
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Configuring the connection for Fiery VDP Resource Manager
The Fiery VDP Resource Manager allows you to view and delete all global objects used 
in variable data printing. For more information, see the Printing Guide.

TO CONFIGURE THE CONNECTION FOR FIERY VDP RESOURCE MANAGER

1. Click Fiery VDP Resource Manager in the Fiery folder.

All servers you connected to previously are displayed. If no servers are displayed, you 
can locate and add them.
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2. Choose Connect from the Server menu.

The Available Servers dialog box appears with all Fiery S300 servers located in the 
subnet displayed.

3. Click the Manual tab to locate a Fiery S300 server by its IP address. Enter the IP 
address and click Add.

Fiery S300 name and device 
name (50C-K)
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4. Click the Auto Search tab and then click Advanced to search by either a range of IP 
addresses or the IP address and subnet mask. 

5. Click Add and then click Search.

All VDP servers located appear in the Available Servers dialog box.

6. Select the servers you want and click Add.

The selected servers appear in the list of VDP servers in the Fiery Variable Data 
Resource Manager dialog box.

Fonts
The Fonts installer on the User Software CD includes screen and printer fonts that 
correspond to the 136 built-in PostScript printer fonts on the Fiery S300. The Font 
installer copies both types of fonts to the System Folder:Fonts folder on your hard 
disk. To be available to applications, the screen fonts must remain in the 
System Folder:Fonts folder. You can copy the printer fonts to a folder of your choice. 

NOTE: In the SystemFolder:Fonts folder, when displayed by Kind, screen fonts appear 
as type “Font Suitcase” and PostScript printer fonts appear as type “PostScript font.”

NOTE: To back up installed fonts, see the Configuration Guide.
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TO INSTALL SCREEN AND PRINTER FONTS

1. On the User Software CD, double-click the Fonts icon to start the Fonts installer. 

NOTE: Access the Fonts icon from the OS 9 folder on the User Software CD.

2. Click Install and restart your computer.

By default, the fonts are installed to the System Folder:Fonts folder on your hard disk.

If you have any applications open, you must quit and restart them before the newly 
installed screen fonts are available.

Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 
Many of the files are PostScript files you can download and print using 
Fiery Downloader.

The User Software CD contains the following color files:

ICC profiles
(inside the 
ColorSync folder)

Install the ICC profiles into the ColorSync Profiles folder 
inside the System Folder.

Color Files folder 
(inside the English 
folder)

CMYK Color Reference.ps, an 11-page, letter-size 
PostScript file to use for reference when defining CMYK 
colors in applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file 
that indicates the closest equivalent of PANTONE coated 
colors that the Fiery S300 and your particular copier model 
can produce. The method used to print the 
PANTONE Book.ps file differs depending on the Spot 
Color Matching setting. For more information, see the 
Printing Guide and the Color Guide.

RGB page 01, a file you can print from Microsoft Word 97 
or later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 or 
later to view available RGB colors.
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Loading ICC copier profiles

The ICC copier profiles are used with ColorWise Pro Tools and applications that 
support ICC standards. 

These instructions assume that you have already installed the ICC copier profiles 
included on the User Software CD inside the ColorSync folder. For more information, 
see “Installing color files from the User Software CD” on page 2-26.

NOTE: The internal name of an ICC copier profile may vary slightly from its file name.

The following procedure describes installing the ICC copier profiles with 
ColorSync 4.0. For more information about ColorSync, see your application’s 
documentation.

Calibration folder
(inside Color Files 
folder)

Four measurements files of color patches: custom21.ps, 
custom34.ps, standard21.ps and standard34.ps. The 
numbers in the file names refer to the number of patches 
on the page. The Custom files are provided to allow you to 
download measurement patches that incorporate the 
copier’s current calibration set. The Standard files are 
provided to allow you to download standard measurement 
patches that bypass the copier’s current calibration set. For 
information on using these files, see the Color Guide.

These files are provided for expert users and should not be 
used for day-to-day calibration.
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TO SET THE COLORSYNC SYSTEM PROFILE

1. Choose Control Panels:ColorSync from the Apple Menu.

2. Select EFIRGB ICC v1f from the System Profile list.

When selected as the ColorSync system profile, EFIRGB ICC v1f sets the optimal 
source color space for printing to the Fiery S300. The color space set by the 
EFIRGB ICC v1f profile is the same as that set by the EFIRGB setting of the RGB 
Source Profile print option. 

NOTE: The RGB Source Profile print option setting overrides the ColorSync system 
profile setting. 

3. Close the ColorSync dialog box.

For more information about ICC copier profiles, see your Adobe Photoshop 
documentation.
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Loading the monitor settings file
The EFIRGB ICC monitor settings file can be used in Photoshop or other applications 
that support ICC profiles to define a source color space for printing to the Fiery S300.

NOTE: For best results, the monitor settings file should be installed if you use 
Fiery Scan.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu, and choose RGB Setup from the Color 
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System Folder:Preferences:ColorSync Profiles folder, select the EFIRGB 
ICC file, and then click Open.

NOTE: If you are using ColorSync 2.5, the ColorSync profile is located in System 
Folder:ColorSync Profiles.

The EFIRGB v1f file appears as the selection.

5. Click OK.
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Loading the ICC copier device profile
The ICC copier profile enables RGB-to-CMYK conversions that are specific to the 
kind of copier you are using. 

TO LOAD THE ICC COPIER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery S300 from the Profile menu.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.
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Loading monitor settings and the ICC device profile in Photoshop 6.x/7.x

In Photoshop 6.x and 7.x, you can load the monitor settings file and the ICC profile at 
the same time.

TO LOAD THE MONITOR SETTINGS FILE AND THE ICC COPIER 
DEVICE PROFILE IN PHOTOSHOP 6.X/7.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the Fiery S300 from the CMYK menu.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your Fiery S300 remotely from the Internet or 
from your company’s intranet.The Fiery S300 has its own home page, from which you 
can select a variety of functions, including Status, WebLink, Installer, 
WebDownloader, WebSetup, and WebScan.

For more information on using Fiery WebTools, see the Printing Guide.

Setting up Fiery WebTools
In order for network users to access and use Fiery WebTools, you must set specific 
Fiery S300 options in Network Setup and Printer Setup. You also must prepare each 
user’s computer to communicate with the Fiery S300 over the Internet or intranet.

For more information about Network Setup and Printer Setup, see the 
Configuration Guide.

TO SET UP CLIENT WORKSTATIONS TO USE FIERY WEBTOOLS

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure a supported Internet browser is installed on the computer.

For more information on supported browsers, see the Quick Start Guide.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery S300 and the network, see the 
Configuration Guide.

Chapter 3:
Downloading 
Installers with 
Fiery WebTools
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Using the Fiery WebTools Installer
The Installer WebTool allows you to download installers for printer drivers and user 
software directly from the Fiery S300 to your computer. 

TO DOWNLOAD PRINTER DRIVERS AND USER SOFTWARE WITH THE 
INSTALLER WEBTOOL

1. Start your Internet or intranet browser and enter the DNS name or IP address of 
the Fiery S300.

2. Select a login level, enter a password if required, and click OK.

No password is required to log in as Guest. If the Administrator has configured Guest 
access, any user has full access to the Installer WebTool while logged in as Guest.

3. Click Installer. 

4. Under the name of your operating system, click the name of the item you want 
to install.
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5. For installation of user software, follow the on-screen instructions.

6. For installation of printer drivers, continue with the following instructions.

A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the 
program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Driver is downloaded to the desktop 
in a BinHex-encoded, compressed format. If your Internet browser is equipped with 
an expander utility, such as StuffIt Expander, the folder decodes and 
decompresses automatically.

7. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe and click Save.

For Mac OS computers, if the Printer Driver folder did not automatically decode and 
decompress, start the utility that performs that function.

8. For Windows computers, double-click the Prntdrve.exe file, browse to the location 
where you want to install the folder, and click Next.

The folder is installed to the location you specified.

9. Install the appropriate printer driver for your operating system.

For instructions on installing 
the printer driver for See

Windows 9x/Me “To install the PostScript printer driver for 
Windows 9x/Me” on page 1-2

Windows NT 4.0 “To install the PostScript printer driver for 
Windows NT 4.0” on page 1-13

Windows 2000/XP “To install the PostScript printer driver for 
Windows 2000/XP” on page 1-28

Mac OS “Setting up the Fiery S300 as a PostScript printer” on 
page 2-1
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows NT/2000/XP computers
If you have problems installing the Fiery S300 with Windows NT 4.0 or 
Windows 2000/XP, try installing another PostScript printer (such as the Apple 
LaserWriter IIg), and then install the Fiery S300. Installing another printer ensures 
that all files are properly installed and available. For instructions, see your 
Windows documentation.

For information about problems you may encounter using the PostScript Printer 
Driver for Windows NT 4.0, see the Adobe README file (readme) included in 
Prntdrvr\Ps_drvr\Win_NT4x on the User Software CD. For Windows 2000/XP, see 
your Windows documentation.

Reinstalling the Adobe PostScript Printer Driver on 
Windows 9x/Me
If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 
and related files before installation.

For additional information about problems you may encounter using the Adobe 
Printer Driver for Windows 9x/Me, see the Adobe README file (readme) included 
in Prntdrvr\Ps_drvr\Win_9x_ME on the User Software CD.

Chapter 4:
Troubleshooting
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Problems with the Fiery utilities on Windows computers
If you are experiencing problems with connections for the Fiery utilities, try 
the following:

1. Make sure the TCP/IP networking protocol is enabled. 

2. Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose Open from the File 
menu. Select the Fiery S300 and click Modify to see current settings. If the settings are 
incorrect, you can change them in this dialog box.

On a Mac OS computer

Setting up the Fiery S300 in the Mac OS 9 Chooser
If Auto-setup does not work and you are prompted to select the printer description file, 
select the appropriate Fiery S300 file on your hard disk drive: SystemFolder: 
Extensions: Printer Descriptions folder, “Fiery S300 50C-K v1.0”.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User 
Software CD to the System Folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System Folder.

3. Move fonts you are not using from the System Folder:Fonts folder to the Uninstalled 
Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts 
to the System Folder:Fonts folder.

5. Create aliases to the System Folder:Fonts folder and the Uninstalled Fonts folder.

6. Place both aliases on your desktop.
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7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and restart them in order to view 
and use the newly installed fonts.

You can also try combining fonts from multiple suitcases into a single suitcase.

Setting up the Fiery S300 in the Mac OS X Print Center 
If Auto-setup does not work and you are prompted to select the printer description file, 
select the appropriate Fiery S300 file in your hard disk drive: System :Library: 
Printers:PPDs: Contents: Resources: language folder (for example, en.lproj) 
folder, “Fiery S300 50C-K v1.0”.
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on Windows NT 4.0 1-25 to 1-27

specifications, color server xii
Spooler, see Fiery Spooler
Stand21.ps (Mac OS) 2-27
Stand21.ps (Windows) 1-64
Stand34.ps (Mac OS) 2-27
Stand34.ps (Windows) 1-64



I-5 Index
T
thinnet cable xii
troubleshooting

Mac OS computers 4-2
Windows computers 4-1

U
Uninstalled Fonts folder 4-2
unshielded twisted pair (UTP) cable xii
user software

downloading installers 3-2
User Software CD

contents (Mac OS) 2-1
contents (Windows) 1-45
installing from, for Mac OS 2-2, 2-26
troubleshooting fonts 4-2

W
WebDownloader WebTool, see Fiery 

WebTools
WebScan xvi
WebSetup WebTool, see Fiery WebTools
Windows

copying color files 1-64
installing Fiery utilities 1-45
troubleshooting 4-1

Windows 9x/Me
setting up PostScript printing 1-1
SMB printing 1-9 to 1-11
troubleshooting 4-1

Windows 2000/XP
IPX 1-39 to 1-40
IPX/SPX 1-39
PostScript printer driver 1-28 to 1-30
printing requirements 1-34
setting up PostScript printing 1-27
troubleshooting 4-1

Windows NT 4.0
IPX 1-24
IPX/SPX 1-22
PostScript printer driver 1-13 to 1-16
printing requirements 1-20
troubleshooting 4-1

WINS Name Server 1-10, 1-26, 1-41
Word, RGB color reference file 2-26
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